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Introduction

SoftSolutions® 4.1 for Windows is the innovative Document Management Software

(DMS) from Novell, Inc. The greatest asset of any organization is information.

SoftSolutions allows locating and utilizing your information assets without knowing

specific document names, applications, or document locations. SoftSolutions

streamlines workflow by eliminating time wasted in recreating and searching for

documents that can be lost in a maze of network drives and directories.

Each department, workgroup and individual in an organization has unique document

management needs. SoftSolutions' open architecture design accommodates those needs

while maintaining enterprise-wide DMS standardization. SoftSolutions can

simultaneously access information from a variety of Windows, DOS or Unix

applications so workgroups are not confined to platform limitations. Furthermore,

SoftSolutions can manage dispersed information located on LANs, Unix systems,

remote offices, laptops, notebooks, and home computers. All this can be done without

compromising an organization's ability to collaborate and share information. The

increased capability of workgroups and individuals to share collective knowledge will

dramatically improve the quality of your products and services.

About This Manual

The User's Guide contains fourteen sections, two appendices and an index:

1. Introduction

2. Getting Acquainted

3. Document Desktop

4. Document Profile

5. Integration with Applications

6. Integration with SoftSolutions Retrieve/Launch

7. Janitor

8. Mark, Launch & EZLaunch

9. Object Linking and Embedding (OLE) 2.0

10. Personalizing SoftSolutions' Look

Colors

Customize Results List

Fonts

General Options

Screen Definition

SpeedButtons

11. Portable Mode
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12. Remote Document Server (RDS)

13. Searching

14. Version Control

Appendices:

A. Keys & Options

B. Terms Glossary

The Introduction contains the following:

• An explanation of SoftSolutions Document Management System

• A brief explanation of the contents of the User's Guide

• Documentation conventions used throughout this guide

Getting Acquainted briefly introduces you to:

• Using SoftSolutions in Windows

• Becoming familiar with the SoftSolutions Window

• Becoming familiar with the fundamental operations of logging in, canceling

operations, using HELP in SoftSolutions, and exiting SoftSolutions

The remainder of the sections in the User's Guide contain the bulk of the

documentation. These sections contain information on performing the everyday

operations in the various users' windows and dialog boxes.

Document Desktop and Document Profile document the alternative methods of user

interface with SoftSolutions.

Personalizing SoftSolutions' Look explains how to use the following windows and

dialog boxes to customize various aspects of SoftSolutions:

• Colors

• Customize Results List

• Fonts

• General Options

• Screen Definition

• SpeedButtons

Appendices include:

• Keys & Options which describes the SoftSolutions cursor movement and function

keys.

• Terms Glossary which provides an alphabetical listing of words and phrases as

they pertain to SoftSolutions.
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Documentation Conventions

A few documentation conventions are used to improve readability and enhance

understanding.

bolded text Field names (e.g., Name field, Copy out document field,

Document Security field, Document Number field).

ALL CAPS Window and dialog box names (e.g., DOCUMENT PROFILE

window, CHECK OUT dialog box); filenames and keyboard

entries (e.g., WORD %P%F).

Key Name Key references are enclosed within Lenticular Brackets,

usually as the appear on an IBM® PC keyboard. For example,

the “a” key is represented as A , the “escape” key is

represented as Esc , and the “plus” key as + .

bold and underline SoftSolutions options selected from the menu bar in Windows.

The bolded and underlined letter represents the mnemonic

letter used to choose an option using the keyboard. When

using mnemonic letters to perform a step, the step is always

preceded by also pressing the Alt key. (e.g., Alt X

chooses the Search Full-Text option).

“monospaced text” SoftSolutions error and confirmation messages (usually within

quotes), and example texts.

[Italicized in Brackets] “Place holders,” which are words that identify information to

be supplied by the user (e.g., C:\[Filename]).
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Getting Acquainted

Getting Acquainted introduces you to:

• Using SoftSolutions in Windows

• Becoming familiar with the SoftSolutions window

• Becoming familiar with the fundamental operations of logging in, canceling

operations, using HELP in SoftSolutions, and exiting SoftSolutions

Using SoftSolutions in Windows

Since SoftSolutions 4.1 for Windows operates in the Windows environment, it uses the

standard Windows rules for choosing icons, menus, and menu items. The following

information should help you to become familiar with using SoftSolutions in Windows.

Using the Mouse

Unless otherwise noted, mouse instructions refer to the left button. If the mouse has

been remapped or a left-hand mouse is being used, use the right button.

When using the mouse, steps may involve performing the basic skills of pointing,

clicking, and dragging.

Point Move the mouse to place the pointer (arrow) over an item.

Click Move the mouse to place the pointer (arrow) over an item and

then quickly press and release the mouse button.

Double-click Move the mouse to place the pointer (arrow) over an item and

then quickly press and release the mouse button twice.

Drag Hold down the mouse button as the pointer is moved.

Choosing Commands

To choose a command from a menu, you can use the mouse or use mnemonic letters.

Mnemonic letters are included with steps to allow quick keyboard access. These letters

are bolded and underlined throughout the manual. For example, “F” for File. When

using mnemonic letters to perform a step, the step is always preceded by pressing the

Alt key.
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For example, if the step states “Choose Exit from the File menu to exit SoftSolutions,”

use the mouse or keyboard as described below to perform the step.

Mouse

1. Point to the File menu, then click the left mouse button.

2. Point to the Exit command, then click the left mouse button. SoftSolutions is

exited.

Keyboard

1. Press the Alt key to activate the menu bar. Then press “F” to open the File

menu.

2. Press “X” to choose the Exit command. SoftSolutions is exited.

Shortcuts

Keyboard Shortcuts

In the documentation, the keyboard icon is used to indicate a keyboard

function (shortcut) for performing an operation. These shortcuts include function

keys and accelerators. For example, rather than choosing Exit from the File menu

to exit SoftSolutions, Alt F4 can be used. Rather than choosing Search from

the Search menu to search for a Profile in the DOCUMENT PROFILE window,

Ctrl S can be used.

To perform this command: Press these accelerators:

SoftSolutions

Access version records Ctrl I

Add a record Ctrl A

Mark a document Ctrl M

Open a document Ctrl O

Preview a document Ctrl V

Search for a record Ctrl S

View a personal worklist Ctrl W

View the search results Ctrl U

Clipboard

Copy to Clipboard Ctrl Ins

Cut to Clipboard Shift Del

Paste from Clipboard Shift Ins
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To perform this command: Use these function keys:

Exit SoftSolutions Alt F4

Access SoftSolutions-based HELP F3

Access Windows-based HELP F1

Return to the DOCUMENT PROFILE F7 or Esc

Mouse Shortcuts

The mouse icon is used to indicate a mouse function (shortcut) for performing

an operation. These shortcuts include SpeedButtons. For example, rather than

choosing Add from the File menu to add a Profile in the DOCUMENT PROFILE

window, the “Add” SpeedButton may be chosen.

To perform this command: Choose this SpeedButton:

Add a Profile Add

Change Datasets Change Dataset

Open a document Open

Preview a document Preview

Search for a document (using Profile data only) Search

Search for a document (w/Profile or full-text data) Search Full-Text

View a personal worklist Worklist

Becoming Familiar with the SoftSolutions Window

On the following page is an illustration of the SoftSolutions DOCUMENT PROFILE

window. The key components of the window have been identified. Following is a brief

description of each component.

drop-down menu Menu of SoftSolutions options, chosen from the menu

bar.

field A location in the window where information is entered

and displayed. Fields are indicated by a field “name.”

field name Each field is associated with a name. This name may

indicate the type of information stored in the field.

look-up button Displays a SoftSolutions LOOK-UP table containing a

valid code listing. Look-up buttons are available for any

field that requires a code entry.
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maximize button Enlarges the SoftSolutions window to fill the monitor.

menu bar Contains a list of SoftSolutions drop-down menus.

minimize button Reduces the SoftSolutions window to an icon.

scroll bars Windows scroll bars are displayed to the right or the

bottom of the window when an entire SoftSolutions

window cannot be displayed on the monitor. The scroll

bars are used to view different portions of the

SoftSolutions window. With the mouse, the display may

be scrolled by clicking the scroll bar or the scroll arrow,

or by dragging the scroll box.

SpeedButton bar With the help of the mouse, provides quick access from

the DOCUMENT PROFILE window to frequently used

SoftSolutions commands.

status bar Displays the current mode (e.g., “Adding,” “Select

Option,” “Changing”). When performing a search in the

DOCUMENT PROFILE window, the status bar also

contains the Search Scope.

control-menu box Contains a list of system options such as Maximize,

Minimize, Open, Close, and Restore.

title bar Displays “SoftSolutions” and the name of the current

window or dialog box. In the DOCUMENT PROFILE

window, the current Dataset ID is displayed.

SoftSolutions for Windows Pointer Shapes

The Windows pointer will assume one of the following shapes:

Shape of the mouse pointer when in the selection mode.

Shape of the mouse pointer when waiting for SoftSolutions to perform a

function.

Shape of the mouse pointer when placed in a data entry field.
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SoftSolutions Document Profile Window
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Fundamental Operations

The following fundamental SoftSolutions operations are discussed in this section:

• Logging In p. 10

• Login Switches p. 11

• Changing the Password p. 18

• Canceling Operations In SoftSolutions p. 19

• Using HELP p. 19, 21

• Exiting SoftSolutions p. 22

Logging In

SoftSolutions can be started by double-clicking on the SoftSolutions icon or by

choosing Run from the File menu, typing “[Programs Directory]\SOFTSOLW” where

[Programs Directory] is the full path to the SoftSolutions programs directory, and

pressing Enter or choosing OK. Optional login switches are also available. (See

“Login Switches” on page 11 for additional information.)

When starting SoftSolutions, the LOGIN window is displayed. Contained in the

LOGIN window is the Organization Name to which the copy is registered and the Serial

Number. This information is recorded at the time SoftSolutions 4.1 is initially installed.

Access: Log into SoftSolutions

In the LOGIN window, perform the following:

1. Enter the user code assigned to you by the system administrator in the Code field

and press Tab .

2. Enter the password assigned to you by the system administrator in the Password

field and press Enter .

• The password can be up to 10 characters.

• The password can be changed. (See “Changing the Password” on page 18

for additional information.)

• To maintain security, the password is not displayed.

• An error indicating that NETWARE.DLL cannot be found is displayed if the

/NOVMAP is used in an OAM command line and the Windows setup does not

have “NetWare” specified as the network.
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NOTE
If a dataset suddenly cannot be accessed and the error “Could not send data to

server” (or something to that effect) is reported, check the SEM screen on the

server. If the message “No space left on device” is displayed, first check the

amount of free disk space on the volume which holds the data directory. If there is

a reasonable amount of free space, do an “NDIR *.*” command in the data

directory. Most likely, one or more of the data files has an owner of “N/A.” This

means that the user who previously held ownership of the file has been removed

from the NetWare Bindery. NetWare prevents SoftSolutions from writing to a file

which does not have a valid owner. Similar problems may occur in datasets

without a SEM, but the error will be different. The error may be “PS.KDT -

Write on end error.”

Login Switches

To speed up entry into SoftSolutions, “switches” may be included on the command line

set up for the SoftSolutions for Windows icon. These switches are optional and can be

used as needed. The switches are:

/DATA=

/DOCNUM=

/EXIT

/ID=

/IMPORT

/INDEX

/JANITOR

/NETPASS=

/PASS=

/POR

/USER=

/VERIFY

In the following login example, switches are used. Any one or more of these switches

can be used in any order to log into SoftSolutions.

G:\SS41\SOFTSOLW/ID=RVM/USER=RVM/PASS=NEW/DATA=G:\SS41\DATA\:SOFTSOL

/DATA=

SoftSolutions stores its “data” files in a directory known as the data directory. When

logging in to SoftSolutions, the location of this data directory is indicated in one of two

ways:

1) use the /DATA= switch, which is followed by the dataset network location of the

SoftSolutions data files; or

2) place the dataset network location in the “DATAPATH” ASCII text file located in

the SoftSolutions programs directory.

The typical format for DATAPATH is:

[Data Directory]:[Dataset ID]
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An example of a DATAPATH for SoftSolutions 4.1 is “G:\SS41\DATA:NY1,” where

the [Dataset ID] is “NY1.” This Dataset ID is defined in the CONTROL FILE window.

When first installing SoftSolutions, the default Dataset ID is “SOFTSOL.” The [Data

Directory] is “G:\SS41\DATA.” This is the directory in which the data files are located.

Drive mapping is not performed on this path.

If a SoftSolutions SEM is used, the format for DATAPATH is:

[Server]:[Object]:[Dataset ID]:[Name Service]

Based on the [Name Service], the [Server] and [Object] must contain specific

information. [Dataset ID] is replaced with the Dataset ID defined in the CONTROL

FILE window. The default is “SOFTSOL” when first installing SoftSolutions. The

[Dataset ID] and [Name Service] components may be in upper or lowercase.

The following table is provided to explain the [Object] and [Server] components of the

DATAPATH based on the [Name Service].

Name Service Server Object

NWB (NetWare

Bindery)

Required The socket number to be used on the

server. If no socket number is defined,

the SoftSolutions designated socket

number is used. The default should be

used unless more than one Dataset

resides on a single server. In such

instances, one of the Datasets should

use the default socket number. The

remainder of the Datasets on the same

server must be assigned a unique

socket number.

IN (Internet) Defaults to the

machine on which

the client software

is running.

Internet service name or socket

number for server. The default is

“SS.”

FIL (File Services) Not required None
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Some examples:

FS1:NY1:NWB — NWB name for a dataset called “NY1” on server “FS1.”

Notice that the default [Object] (socket number) is used.

FS2:32765:NY2:NWB — NWB name for a dataset called “NY2” on server “FS2”

accessed via socket 32765.

SPIKE:2094:KPS:IN — IN name for a dataset called “KPS” on the server

“SPIKE” accessed via the [Object] (socket number) 2094.

/DOCNUM=

This switch allows a particular document's Profile to be immediately displayed upon

first accessing the SoftSolutions DOCUMENT PROFILE window. The /DOCNUM=

switch is followed by a Document Number. If a user does not have rights to the Profile,

or if the Document Number is invalid, the Profile does not display.

/EXIT

The /EXIT switch is used to exit SoftSolutions at a specified time or after a specified

period of idle time. This switch can be used with the /ID=, /USER=, /PASS=,

/IMPORT, /INDEX, /JANITOR, and /DATA= switches. When used with the /IMPORT

and /JANITOR switches, the respective utility is exited upon completion of the

operation. When used with the /INDEX switch, the SoftSolutions Indexer is exited

when all of the indexing requests have been processed.

The /EXIT switch can also be used to exit the Indexer at a specified time. This is done

by using the switch /EXIT=HH:MM replacing HH:MM with a specific time in 24-hour

format. For example, SOFTSOLW/INDEX/EXIT=23:3 /0 will exit the Indexer soon after

11:30PM. At 11:30PM, the Indexer will either complete the request on which it is

currently working or complete the 2-minute waiting period before exiting. Additionally,

the /EXIT=HH:MM switch can be used without the /IMPORT, /INDEX, or /JANITOR

switch to exit the user from any normal SoftSolutions window at a specified time if no

operation is being performed at that time.

Lastly, the /EXIT switch can be used to exit users from SoftSolutions if no operation is

performed for a specified number of minutes. This is done using the switch /EXIT=mm

replacing mm with the number of minutes. For example, SOFTSOLW/EXIT=1/0 will

exit the user from SoftSolutions if the cursor sits idle for 10 minutes without choosing

an option.
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/ID=

The /ID= switch is followed by a Workstation ID (up to eight characters), which is used

by the WORKSTATION window to determine the location of temporary files, the

location to which echoed files are saved, and the maximum size of the directory used for

echoing. This switch can be placed in an icon's command line. If the /ID= switch is not

used, SoftSolutions uses a generic configuration associated with the default ID of

“(MSWIN).”

For easier management, file attributes should be checked before selecting a

Workstation ID naming methodology. Examples:

/ID=[Network Address]

• The DOS network address is eight characters or less.

/ID=[Initials]

/ID=[Unique Workstation Numbers]

/IMPORT

The /IMPORT switch is used for accessing the IMPORT PROFILED DOCUMENTS

utility directly rather than by accessing it from within SoftSolutions' Utilities menu.

This switch can be used with the /ID=, /USER=, /PASS=, /EXIT, and /DATA=

switches. When using the /IMPORT switch without the /EXIT switch, the

DOCUMENT PROFILE window automatically returns when the operation is

completed. When used with the /EXIT switch, SoftSolutions is automatically exited.

The /IMPORT switch may be followed by a directory specification (e.g.,

/IMPORT=F:\DOCS), indicating the location of the documents to be imported. If no

directory is defined, the user is prompted for a directory.

If a user who does not have access to the IMPORT PROFILED DOCUMENTS window

attempts to use the /IMPORT switch, error 676 is displayed and the DOCUMENT

PROFILE window is displayed.

/INDEX

This switch is designed to run SoftSolutions' Indexer utility directly rather than by

accessing it from within SoftSolutions' Utilities menu. This is useful when a

workstation is dedicated to performing only indexing. This utility can be protected

using screen security to prevent unauthorized use.

This switch can be used with the /ID=, /USER=, /EXIT, /PASS=, and /DATA=

switches. When using the /INDEX switch, SoftSolutions is exited immediately upon

exiting the Indexer.
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This switch should be reserved for use only by the system administrator.

If a user who does not have access to the Indexer utility attempts to use the /INDEX

switch, the error “User does not have access to this program.” is displayed.

/JANITOR

The /JANITOR switch is used for entering the JANITOR directly rather than by

accessing it from within SoftSolutions' Utilities menu. This switch can be used with the

/ID=, /USER=, /PASS=, /EXIT, and /DATA= switches. When using the /JANITOR

switch without the /EXIT switch, the DOCUMENT PROFILE window automatically

returns when the JANITOR is completed. When used with the /EXIT switch,

SoftSolutions is exited.

This switch can be used to force users to run the JANITOR utility on the Echo Location

defined in the WORKSTATION window.

If a user who does not have access to the JANITOR utility attempts to use the /JANITOR

switch, the error “User does not have access to this program.” is displayed.

/NETPASS=

The /NETPASS= switch is followed by a password of up to 16 characters, which is used

by SoftSolutions for access to other file servers. When a document to be accessed from

within SoftSolutions is located on a server to which a user is not currently attached,

SoftSolutions tries to automatically establish a temporary file server attachment. This is

done using the user code used to log into the current server and the password following

the /NETPASS= switch. If the /NETPASS= switch is not used or the user/password

combination is not valid, the [FILE SERVER] LOGIN box is displayed and prompts the

user for a valid user/password combination.

If files are spread across several file servers, the /NETPASS= login switch should be

used for Indexers because keyboard interaction with the [FILE SERVER] LOGIN box is

not possible when an Indexer is running.

NOTE
If a given user has the same user/password combination on each file server to which

access is needed, the [FILE SERVER] LOGIN box need not display. The

attachment/detachment with file servers during document accessing is transparent

to the user.
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If the /NETPASS= switch and its accompanying password
are placed in the icon's command line, security of the
password can be compromised.

/PASS=

The /PASS= switch is generally used in an icon's command line with the /USER=

switch to save the step of entering the password at the keyboard during login. The

/PASS= switch is followed by a password of up to 10 characters initially defined in

SoftSolutions by the system administrator.

If the password following the switch is invalid, the SoftSolutions LOGIN window

prompts for both the user code and password.

If the /PASS= switch is used, the /USER= switch must also be used. However, the

/PASS= switch does not need to be used if the /USER= switch is used (then only entry

of the password is required in the LOGIN window).

The password can be changed when logging in to SoftSolutions. To change the

password, the /PASS= switch cannot be used.

If the /PASS= switch and its accompanying password are
placed in an icon's command line, security of the password
can be compromised.

/POR

The /POR switch indicates that SoftSolutions is being used in Portable Mode. This

switch can be used with the /DATA=, /DOCNUM=, /EXIT, and /USER= switches. The

/DATA= switch is followed by the path to the directory in which the documents and

their corresponding [Document Number].PRO files are located. If no documents exist,

the /DATA= switch is followed by the path to which documents created are to be placed

while in Portable Mode.

/USER=

The /USER= switch is generally used in an icon's command line to save the step of

entering the user ID code at the keyboard during login. The switch is followed by a user

code of up to eight characters defined in SoftSolutions by the system administrator.
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Using the /USER= switch, you can specify that the user code should be obtained from

the network. Currently, this is only available for Novell NetWare (DOS and Windows

only), and Unix. To obtain the code from the NetWare Bindery, the switch is

/USER=%NWB. To obtain the code from a Unix operating system, the switch is

/USER=%OS. When using the /USER= switch in one of these two manners, a password

is not required for accessing SoftSolutions.

NOTE
When using /USER=%NWB in a DOS batch file, the format must be

/USER=%%NWB. “NWB” must be preceded by two percent signs (%%), rather

than a single percent sign (%).

• When /USER=%NWB is used to log into SoftSolutions and the Novell user code is

more than eight characters, the error “Invalid User/Password” is displayed.

If the /USER= switch is not used, if the code following the switch is invalid, or the code

cannot be obtained from the NetWare Bindery or the Unix operating system, the

SoftSolutions LOGIN window prompts for both the user code and password.

/VERIFY

The /VERIFY switch is used to access the VERIFICATION utility. This switch can be

used with the /USER=, /PASS=, and /DATA= switches. When using the /VERIFY

switch, SoftSolutions is exited immediately upon exiting the VERIFICATION utility.

This switch should be reserved for use only by the system administrator.

If a user who does not have access to the VERIFICATION utility attempts to use the

/VERIFY switch, the error “User does not have access to this program.” is

displayed.
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The following table indicates all of the valid switch combinations:

D
a
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=
H
H
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M
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D
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J
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e
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e
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y

Data - Y Y Y Y Y Y Y Y Y Y n Y Y Y

Docnum Y - Y Y Y Y Y n Y Y Y Y Y Y Y

Exit Y Y - n n Y Y Y Y Y Y n Y Y n

Exit=HHM
M

Y Y n - n Y Y Y Y Y Y Y Y Y n

Exit=MM Y Y n n - Y Y Y Y Y Y Y Y Y n

ID Y Y Y Y Y - Y Y Y Y Y n Y Y Y

Import Y Y Y Y Y Y - n n Y Y n Y Y n

Index Y n Y Y Y Y n - n Y Y n Y Y n

Janitor Y Y Y Y Y Y n n - Y Y n Y Y n

Netpass Y Y Y Y Y Y Y Y Y - Y n Y Y n

Pass Y Y Y Y Y Y Y Y Y Y - n Y Y Y

Por n Y n Y Y n n n n n n - Y Y n

Snow Y Y Y Y Y Y Y Y Y Y Y Y - Y Y

User Y Y Y Y Y Y Y Y Y Y Y Y Y - Y

Verify Y n n n n Y n n n n Y n Y Y -

Changing the Password

Each password may initially be the same as the user code. This is done in the USERS

window. Perform the following steps in the SoftSolutions LOGIN window to change

the password:

1. Enter a valid user code in the Code field and press Tab .

2. Type the password in the Password field and immediately choose Chg Passwd.

The password cannot be changed when using the /PASS= switch.
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• The password can be up to 10 characters.

• To maintain security, the password is not displayed.

• The CHANGE PASSWORD dialog box is displayed.

3. Enter the new password and press Enter .

• SoftSolutions prompts for reentry of the new password. This ensures the

password is correctly entered.

4. Re-enter the new password and press Enter . One of the following occurs:

a. If the password entered the second time does not match the first entry of the

new password, error 509 is displayed and the password is not changed.

Choose OK and SoftSolutions is accessed using the old password.

b. If both new entries match, SoftSolutions indicates the password is being

updated for the next login. SoftSolutions is then accessed.

• The password is not available for viewing in SoftSolutions. If the

password is forgotten, the system administrator must assign a new

password.

Canceling Operations In SoftSolutions

Pressing the Esc key or choosing Cancel cancels any operation in SoftSolutions.

Depending on the SoftSolutions settings, a CONFIRM message box may display when

pressing Esc or choosing Cancel. Choose No to cancel the exit and remain in the

window in the selected mode. Choose Yes to confirm cancellation of the operation.

Any information entered in the window is not saved.

Using HELP

While in SoftSolutions, HELP is available for SoftSolutions in both the SoftSolutions

and Windows formats. Access HELP anytime, especially when first using

SoftSolutions.
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Invoking HELP

Windows-based HELP. Windows-based HELP is accessed by choosing the

appropriate option from the Help menu, by choosing Help, or by pressing F1 .

Windows-based HELP provides an index, hypertext links, and keyword searching.

SoftSolutions-based HELP. When in a menu, F3 is used to access SoftSolutions-

based HELP. When the cursor resides in a field, SoftSolutions-based HELP is accessed

by clicking on the LOOK-UP button located to the right of the field in which the

cursor resides or by pressing F3 .† Different levels of HELP are available in

SoftSolutions. The level of HELP initially accessed depends on the location of the

cursor when HELP is invoked.

When in a field requiring a valid code entry, a LOOK-UP table is initially accessed. A

LOOK-UP table contains a list of the valid codes. By default, this list is sorted

alphabetically by code. To sort the list alphabetically by description, click the

Description radio button to its ON state or press Tab . The list is immediately

resorted. Several options are available for viewing the contents and selecting an entry.

The cursor movement keys and the various scroll bars can be used for moving through

the list. To select an entry, highlight the desired code and press Enter or double-click

on the record.

† SoftSolutions-based HELP is not available in SoftSolutions dialog boxes.
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When in a menu or in a field not requiring a valid entry, a window containing general

information on a menu, option, window, or field is initially accessed. HELP may

consist of several pages. Page Up and Page Down can be used to scroll through

the text.

Lastly, a general HELP window providing instructions on using the keys and options is

available. This level of HELP is accessed by pressing the HELP key ( F3 ) while

displaying the general information HELP on the menu, window, option, or field.

Each level of HELP is accessed through successively pressing the HELP key ( F3 ).

For example, while in a field requiring a code entry, press the HELP key for a

LOOK-UP table on the code, press the HELP key again to display the context-sensitive

HELP for the field, and press the HELP key yet again to provide the general help on the

keys and options.

Exiting HELP

SoftSolutions-based HELP is exited by pressing Esc or by double-clicking on the

control-menu box. Windows-based HELP is exited by choosing Exit from the File

menu, by double-clicking on the control-menu box, or by pressing Alt F4 .

Using the Browse Button

In fields requiring a path or a path and filename, the Browse button can be used to locate

the desired directory or file. When choosing Browse, the BROWSE dialog box is

displayed. Provide the following information to locate the desired file.

File Name

Enter the name of the desired file in the File Name field or select the file from the list

box. If only a portion of the filename is known, enter the template in the File Name

field to view a listing of the files matching the template in the specified directory. For

example, if it is an executable file, enter “*.exe” in this field. This field is available

only if the field is requesting a path and filename.
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Directories (or Path)

Enter the directory in which the file is located or to which the file is to be placed or

select the directory from the list box. If the directory you want is not displayed in the

list box, the incorrect drive may be specified. When in a field which is requesting a path

only, the field name is Path.

List Files of Type

Enter the type of files to be displayed in the File Name list box or select the type from

the drop-down box. For example, choosing Text Files will list all files with a .TXT

filename extension in the specified directory. This field is available only if the field is

requesting a path and filename.

Drives

Enter the drive in which the file is located or to which the file is to be placed or select

the drive from the drop-down box. When selecting a drive, the directories on the drive

are displayed in the Directories list box.

Once the desired path or file has been located and selected, choose OK to place the

entry in the appropriate field.

Exiting SoftSolutions

SoftSolutions is exited by choosing Exit from the File menu in the DOCUMENT

PROFILE window, or by pressing Alt F4 or double-clicking on the control-menu

box while in any SoftSolutions window. Depending on the SoftSolutions settings,

SoftSolutions may be exited immediately or the CONFIRM message box may be

displayed. Choose No to cancel the exit and remain in SoftSolutions. Choose Yes to

confirm the exit. SoftSolutions is exited.
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Document Desktop

SoftSolutions Document Desktop is a Windows application designed to take advantage

of the graphical environment of Microsoft Windows. Document Desktop is a graphical

user interface to SoftSolutions with iconic representation of Documents, Folders,

Applications, Services, and SoftSolutions search criteria (EZSearch). With this new

graphical view of Document Management Systems, users are allowed to personalize

their organization of the documents and services used. Users can interact directly with

the documents and the applications associated with document creation and analysis.

Using icons and drag-and-drop technology, SoftSolutions Document Desktop will

become the standard for user interface in the graphical environment of Windows.

SoftSolutions Document Desktop Objects

Five types of objects are available for Document Desktop (listed alphabetically):

Application

Document

EZSearch

Folder

Service

Each type of object has several “properties” associated with it. These properties

describe the object and what it can do, and are listed below for each type.

Each object has an icon and description associated with it, since the objects are

represented in Document Desktop by icons. The other properties indicate its

functionality.

Application

Applications, such as those contained in the SoftSolutions for Windows

APPLICATIONS window (e.g., WordPerfect, Microsoft Word, Excel), as well as any

applications which can be run at the command line under Windows, can be placed on

the desktop. By doing so, Document Desktop can almost entirely replace the Program

Manager as the controlling operation from the user standpoint.

Document Desktop Document Desktop Objects 23



Each application will have a set of properties that must be established by the user.

These properties include:

1. Icon

2. Description

3. Execute command

4. Maximum number of documents to accept at one time

5. Working directory

6. Run minimized

7. Accept documents of which type

8. If a Launch: SoftSolutions dataset, SoftSolutions Launch command

Document

A Document icon has a direct relationship with a Profile in the SoftSolutions database.

Each Document object represents a profiled document. No documents may exist in

Document Desktop without being profiled in SoftSolutions. Documents may be on the

desktop as individual entities or inside Folders. A single, profiled document may be

represented many times on the desktop. Multiple versions of a document cannot be

placed on the desktop. All documents on the desktop represent the most current version

of the document.

The properties of a Document include:

1. Icon

2. Description

3. Document number

4. Dataset

EZSearch

An EZSearch object represents a saved search criteria. The criteria from all of the

SoftSolutions searching methods can be stored. When opened, this object re-executes

the associated search and the search results are displayed in the SEARCH RESULTS

window.

The properties of an EZSearch include:

1. Icon

2. Description

3. Search criteria

4. Search scope
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Folder

A Folder is a storage item that may contain any combination of Desktop

objects—Documents, EZSearches, Services, Applications, Shared Icon Lists and other

Folders. When creating a new Folder, it is initially empty and sized in proportion to its

parent. Its properties are inherited from the parent but may be modified.

The properties of a Folder include:

1. Icon

2. Description

3. Background color (when open)

4. Icon spacing

5. Shared icon list

Service

Services are any options available in Document Desktop. These Services can be used to

locate, view, create, and manipulate SoftSolutions documents and Profiles. Services are

also available for determining the contents and appearance of Document Desktop.

Some of the Services require the user to access a SoftSolutions window while other

Services will use the SoftSolutions OAMs and DLLs to perform their functions in the

background. Icons for Services related to SoftSolutions options will match those icons

used in SoftSolutions for Windows. SoftSolutions document security will be enforced

in Document Desktop.

The properties of a Service include:

1. Icon

2. Description

3. Maximum number of documents to accept at one time

Using SoftSolutions Document Desktop

Since Document Desktop operates in the Windows environment, it uses the standard

Windows rules for choosing icons, menus, and menu items. The following information

should help in becoming familiar with using Document Desktop.

Using the Mouse

Unless otherwise noted, mouse instructions refer to the left button. If the mouse has

been re-mapped or a left hand mouse is being used, use the right button.
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When using the mouse, steps may involve performing the basic skills of pointing,

clicking, and dragging.

Windows Function Operation Performed

Click Move the mouse to place the pointer ( ) over an item,

then press and release the mouse button. NOTE: This

selects a single icon—holding down the Shift key

while clicking selects multiple icons.

Double-click Move the mouse to place the pointer ( ) over an item,

then quickly press and release the mouse button twice

Drag-and-drop Move the mouse to place the pointer ( ) over an item,

press and hold the mouse button down as the pointer is

moved to the desired location, then release the mouse

button. NOTE: This moves the object—holding the

Ctrl key down while performing drag-and-drop copies

the object.

Marquee-select Move the mouse pointer ( ) over any unused area, press

and hold the mouse button down as the pointer is moved

to select the desired objects with the dotted-line box (an

entire object does not need be within the box to be

selected), and release the mouse button.

Point Move the mouse to place the pointer ( ) over an item.

Choosing Commands

To choose a command from a menu, use the mouse or use the mnemonic letters.

Mnemonic letters are included with steps to allow quick keyboard access. These letters

are bolded and underlined throughout the manual. For example, “F” for File. When

using mnemonic characters in the main menu, the step is always preceded by pressing

the Alt key. In submenus, simply press the mnemonic letter.

For example, if the step states “Choose Exit from the File menu to exit,” use the mouse

or keyboard as described below to perform the operation.

Mouse

1. Point to the File menu, then click the left mouse button.

2. Point to the Exit command, then click the left mouse button. The program is

exited.
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Keyboard

1. Press the Alt key to activate the menu bar. The press “F” to open the File menu.

2. Press “X” to choose the Exit command. The program is exited.

Accelerators

In the documentation, the keyboard icon is used to indicate a keyboard function

(shortcut) for performing an operation. These shortcuts include function keys and

accelerators. For example, rather than choosing Exit from the File menu to exit,

Alt F4 can be used. Following is a list of the menu options and their accelerators:

File Option Accelerator Keys

Document Preview Ctrl V

File Exit Alt F4

File New Document Last Search Results Ctrl U

File New Document Profile Search Ctrl S

File New Document Worklist Ctrl W

File Open Enter or Ctrl R

File Print Ctrl P

File Properties Alt Enter

File Remove Delete

Locate Last Search Results Ctrl U

Locate Profile Search Ctrl S

Locate Worklist Ctrl W

Options Menu Off Alt F10

Profile Add Ctrl A

Keyboard Selection of Icons and Folders

Certain keyboard combinations can speed selection of icons or Folders in Document

Desktop.

Keys Result

Ctrl Tab Selects the next Folder.

Shift Ctrl Tab Selects the previous Folder.

or Deselects the current icon and selects the next icon.

Shift or Shift Leaves the current icon selected and also selects the

next icon.
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Using HELP

While in Document Desktop, Help is available for Document Desktop in the Windows

format. Access Help anytime, especially when first using Document Desktop. Help is

accessed by choosing the appropriate Help menu option or by clicking on the Help

button in many of the dialog boxes. Available in the Help is an index, hypertext links,

and keyword searching. Help is exited by choosing Exit from the File menu.

Fundamental Operations

The fundamental operations in Document Desktop are starting, exiting (including

exiting SoftSolutions), and working with multiple documents.

Starting Document Desktop

Document Desktop can be started by double-clicking on the SoftSolutions Document

Desktop icon. Following is a sample Document Desktop group window:

The Document Desktop program files must be installed by the system administrator for

it to be available to end users. Then, the first time users accesses Document Desktop,

File Run must be used on their PCs so that the Document Desktop group and icon can

be created as part of an automatic “New User” routine. The Document Desktop icon

will thereafter be available for easy access. The system administrator must use the

following information to develop the instructions to be given to each user who will be

using Document Desktop.
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The command line syntax used to access Document Desktop (the /DESKDATA= switch

is automatically included in the DESKDATA.INI file as part of the “deskdata=” line,

and only needs to be included if changed from the default):

[Document Desktop Programs Directory]\SSDSKTOP.EXE
/DESKDATA=[Document Desktop Data Directory]

For example, the full command line might be:

F:\DESKTOP\SSDSKTOP.EXE /DESKDATA=F:\DESKTOP\DATA

The SoftSolutions /ID= and /DATA= switches may also be used, but only in the

DESKDATA.INI file as part of the “sscommand=” line. The /ID= switch is followed by

the Workstation ID code used to determine which SoftSolutions Workstation ID record

is to be used. The /DATA= switch is followed by the location and Dataset ID of the

SoftSolutions dataset being used. (For additional information on the /ID= and /DATA=

switches, see the Getting Acquainted section of the SoftSolutions User's Guide.)

When logging into SoftSolutions, Document Desktop will look for a subdirectory in the

Document Desktop data directory matching the code entered in the User field of the

SoftSolutions LOGIN window.

Each user must have a subdirectory in the Document Desktop data directory for storing

the Desktop settings. When logging into SoftSolutions Document Desktop,

SoftSolutions will check for the existence of a subdirectory matching the User code used

to log into SoftSolutions. If it exists, Document Desktop is accessed. If this

subdirectory is not located, a message box is displayed asking if you are a new user. If

Yes is chosen, this subdirectory is automatically created, the default settings are used,

and the user is automatically given Read and Write access to the user subdirectory. If

No is chosen, Document Desktop is not accessed.

“Using default settings” may be displayed when accessing Document Desktop if

the file, DESKTOP.SET, is not found in the user's subdirectory. This file is

automatically created when first accessing Document Desktop. Ensure you have

sufficient rights to your user's subdirectory to create and write to this file.
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